# Table of Contents

Five Step Legal Research Process: Overview ................................................................. 4

Five Step Legal Research Process: Elements ............................................................... 5
  Step 1: Formulate a Research Plan ........................................................................... 5
  Step 2: Consult Secondary Sources ....................................................................... 5
  Step 3: Search for Primary Authority .................................................................... 6
  Step 4: Expand & Update Primary Law .................................................................. 6
  Step 5: Analyze & Organize Results ..................................................................... 6

Secondary Sources ........................................................................................................ 7
  Treatises .................................................................................................................. 7
  Legal Encyclopedias ............................................................................................... 7
  American Law Reports (ALR) ................................................................................ 8

Major Sources of Statutes ........................................................................................... 9
  Federal Statutory Sources ....................................................................................... 9
  Florida Statutory Sources ..................................................................................... 10

Major Sources of Case Law ......................................................................................... 11
  Federal Case Law ................................................................................................... 11
  Florida State Case Law .......................................................................................... 11

Case Law Citations: Quick Reference ...................................................................... 13

Major Sources of Administrative Regulations ......................................................... 15
  Federal Administrative Regulations ..................................................................... 15
  Code of Federal Regulations & e-CFR ................................................................. 15
  Federal Register .................................................................................................... 16
  Florida Administrative Regulations ...................................................................... 17

Using Citators ............................................................................................................. 19
  Basic Citator Information ...................................................................................... 19
  Using the Shepard’s Citator in Lexis Advance ...................................................... 19
    Shepard’s Signals for Cases ................................................................................ 21
  Using the KeyCite Citator in WestlawNext ......................................................... 22
    Signals in WestlawNext ..................................................................................... 24
Using Headnotes

General Information about Headnotes

Using Headnotes in WestlawNext

Expanding a case using a relevant headnote

Updating a case using KeyCite:

Using headnotes in Lexis Advance

Expanding a case using Lexis Headnotes

Updating a case using Shepard’s.

Searching: Terms & Connectors (Boolean) v. Natural Language

What is Terms & Connectors (T&C) Searching?

What is Natural Language Searching?

Finding Aids

Index

Table of Contents

Table of Cases & Table of Laws

Other Research Resources

Free Sources of Law Online

General Research Tips

Research Checklist
FIVE STEP LEGAL RESEARCH PROCESS: OVERVIEW

Step One: Formulate a Research Plan

Step Two: Consult Secondary Sources
- Constitutions & Statutes
- Case Law
- Rules & Regulations

Step Three: Consult Primary Sources

Step Four: Expand & Update Primary Law

Step Five: Analyze & Organize Results
**FIVE STEP LEGAL RESEARCH PROCESS: ELEMENTS**

This five step research process can be applied to almost any research project, but it’s important to remember that it is not a rigid formula. Be flexible: sometimes you will get to step three and realize you have to go back and revise your research plan. Or you might have some preliminary knowledge, so you can start with step two or three. Ultimately, the five steps provide structure for your research, and can help you when you don’t know where to go next.

**Step 1: Formulate a Research Plan**

Consider the following preliminary questions:
- Legal question(s) that you need to answer
- Relationship between the parties
- Legal terms of art
- Area of law
- Jurisdiction
- Most relevant facts

Generate search terms before you begin your research. This will help you to:
- Navigate indexes and tables of contents, and conduct keyword searches; and
- Create both natural language and terms and connectors search terms

You may not be able to answer every preliminary question—**that’s okay**. Part of the research process is identifying known and unknown information. Answer what you can, then move to Step 2.

**Step 2: Consult Secondary Sources**

Depending on your familiarity with a particular area of law, you will consult different types of secondary sources. More detailed information about Secondary Sources begins on page 7.

If you are unfamiliar with an area of law, consult General Secondary Sources such as:
- Legal Encyclopedias
  - State-specific, such as *Florida Jurisprudence 2d* (FlaJur); or
  - National, such as *American Jurisprudence 2d* (AmJur) or *Corpus Juris Secundum* (CJS)
- *American Law Reports* (ALR)
- General law journals (e.g., *Florida Law Review*)

If you are familiar with an area of law, consult Subject-specific Secondary Sources such as:
- Treatises focused on a discrete area of law (e.g., *Wharton’s Criminal Law*)
- Restatements (e.g., *Restatement (Second) of the Law of Torts*)
- Subject-specific law journals (e.g., *Florida Journal of Law and Public Policy* or *Harvard Environmental Law Review*)

As you develop your knowledge of a particular area, subject-specific secondary sources become more useful.
Step 3: Search for Primary Authority
The secondary sources you consulted in Step 2 should lead you directly to primary sources via references and footnotes. More detailed information about Primary Sources begins on page 9.

Once you find relevant primary sources, those primary sources should lead you to other relevant primary sources:
- Annotated codes and regulations lead you to case law, other code sections, and secondary sources.
- Cases lead you to authorities they rely upon – statutes, regulations, and other cases.

Step 4: Expand & Update Primary Law
Step 4 has two parts: (a) expanding your research using headnotes; and (b) updating the primary law that you’ve found to ensure that the law is still good law. Both parts rely on Shepard’s and/or KeyCite.
- Expand your research by:
  - Exploring relevant headnotes in the cases you’ve already found to find cases that cite to the case based on those headnotes; or
  - Using Topic and Key Number systems to find additional cases indexed under the same topic as a relevant case.
- Update your research (using Shepard’s and/or KeyCite). You must update research in order to:
  - Ensure that the cases, statutes, and regulations you plan to use in your argument haven’t been overruled or otherwise treated negatively; and
  - Determine whether there is more recent case law ruling on the same issue.

Step 5: Analyze & Organize Results
In Step 5, analyze your research (and, by extension, any arguments and drafts that you have started to write). Focus on the following:
- Identify gaps in your writing and/or analysis by reviewing each sentence/paragraph/argument, and asking:
  - Do I need to cite to a primary authority here?
  - Does my argument have all necessary components?
    - E.g., if there are five factors in a legal test, have I addressed all five factors?
    - Are the facts from the cases that I’ve found sufficiently analogous to the facts of my case?
  - If you need to do more research, return to steps one and two.
- Review and amend your search terms.
  - Try a different jurisdiction to see if there are synonyms for the terms you have used.
  - Try natural language searches instead of terms and connectors (or vice versa).
- Go back to secondary sources.
  - Try to find a subject-specific source (treatise, journal article).
  - Use different finding methods to identify secondary sources (indexes, tables of contents, annotated codes).
SECONDARY SOURCES

Secondary sources are “materials about the law that are used to explain, interpret, develop, locate or update primary sources.” STEVEN M. BARSKY, ROY M. MERSKY & DONALD J. DUNN, FUNDAMENTALS OF LEGAL RESEARCH 10 (9th ed. 2009). That is, they are everything besides the law itself.

Though you may wish to dive directly into researching primary sources, it is usually much better to start your research with secondary sources. Secondary sources not only direct you to relevant primary material, they also explain and illuminate legal concepts that might take longer to understand than when consulting only primary sources. The following pages discuss the characteristics of and guidance for using specific secondary sources.

Treatises

**Treatise Characteristics:**
- Exhaustive, comprehensive, in-depth.
- Devoted to one area of law.
- Regularly updated with references to new primary authority.
- Most helpful when:
  - The law is complex;
  - The law differs widely among states; or
  - The area of law is heavily regulated – e.g., Tax, Environmental Law, Banking.

**When to use treatises:**
- If you know the area of law you need to be researching (e.g., criminal law, tort law, securities regulation).
- If you have a basic understanding of the area of law and need more detail, discussion, and citations to primary sources.

**How to find relevant treatises:**
- Consult Georgetown Law’s Treatise Finder at: http://www.law.georgetown.edu/library/research/treatise-finders/index.cfm;
- Search the library catalog for “treatise and [the area of law];”
- Ask the librarian at your job or contact an LIC librarian.

Legal Encyclopedias

**Legal Encyclopedia Characteristics:**
- Provide a general overview of the law.
- Have general statements of law with introductory explanations.
- Arranged alphabetically by subject.
- Contain references to primary sources.
- Neutral - No criticism or suggestion.
Specific legal encyclopedias:

- Two major national encyclopedias:
  - *American Jurisprudence* 2d (AmJur)
  - *Corpus Juris Secundum* (CJS)

- Several state encyclopedias:
  - *Florida Jurisprudence* (FlaJur)
  - For other states, see Georgetown Law’s state guides at:

When to use legal encyclopedias:

- If you need a broad overview of the topic or the law (detail will come later).
- If you don’t know the:
  - Area of law (you can’t pick a relevant treatise unless you know the area of law)
  - Controlling authority (is the issue governed by statute? By common law? Is it a constitutional issue?)
  - Jurisdiction (is the issue federal, state, or local? A combination?)
    - National encyclopedias such as *AmJur* or *CJS* can help.

**American Law Reports (ALR)**

ALR Characteristics:

- Surveys case law across jurisdictions on discrete legal topics, frequently topics dealing with unsettled areas of law.
- Cases are organized by:
  - Jurisdiction and court
  - Fact patterns
  - Nature of holding
- Incredibly comprehensive information source, but limited by discreteness of its topics.
  - If you find a relevant ALR, it will likely be the best source for your research.

When to use ALRs:

- If you know the controlling legal concepts and terms of art:
  - e.g., did the statute violate the Equal Protection clause of 14th Amendment?
- If you need to find cases with specific fact patterns or settings:
  - e.g., breach of contract in an employment context.
- If you need to find cases with specific holdings:
  - e.g., negligence was not found when defendant acted in X manner but was found when defendant acted in Y manner.
MAJOR SOURCES OF STATUTES

Almost all legal research projects will involve statutes, and you should always begin your research into primary sources by searching for a relevant statute. You can access both federal and state statutes via a variety of sources and methods.

Remember that statutes are published in two forms: the official versions that you can cite, and the unofficial, annotated versions that you should use when you research.

Federal Statutory Sources

Most research into federal statutory law should be conducted in an annotated version of the United States Code. WestlawNext and Lexis are the best online sources for the Code because of their currency and annotations. You should always also check an official source to ensure the currency of any statute section cited.

The best way to research a statute is to use the Table of Contents or the Index. The Table of Contents allows you to browse by subject. The Index (only on WestlawNext) provides a controlled vocabulary to help you determine what language and legal terms of art the statute uses.

WestlawNext

- Home → Type “USCA” in the Search box.

Lexis Advance

- Home → Type “USCS” in the Search box.
- Home → Browse → Sources → By Category → Statutes and Legislation → either (1) click U.S. Federal under Jurisdiction or (2) click “U” (across the top) → Scroll to USCS – United States Code Service – Titles 1 through 52 → click Table of Contents or click the down arrow and click “Get documents.”

Print Statutes

- United States Code (official, unannotated)
- West’s United States Code Annotated (unofficial, annotated)
- Lexis United States Code Service (unofficial, annotated)

Free Online Sources

  - Search tip:
    - Click Advanced Search (to the far right of the search box).
    - Type your keywords into the “Search For” search box (about halfway down the screen).
In the drop-down menu next to “Within,” select Statutory Text. This will search only the actual text of the statute for your keywords.

- FDsys (Government Publishing Office) (http://purl.access.gpo.gov/GPO/LPS2873)
- Legal Information Institute (http://www.law.cornell.edu/uscode)

**Florida Statutory Sources**

The official publication of the Florida code is *Florida Statutes*. Just as with federal statutes, research should be conducted in an annotated version of the Florida code, but you should check with an official source to confirm the currency of the statute before citing to it.

The best way to research a statute is to use the Table of Contents or the Index. The Table of Contents allows you to browse by subject. The Index (only on WestlawNext) provides a controlled vocabulary to help you determine what language and legal terms of art the statute uses.

**WestlawNext**
- Home → Type “Florida Statutes” in the Search box.
- Home → Statutes & Court Rules → State: Florida

**Lexis Advance**
- Home → Type “Florida Annotated Statutes” in the Search box.
- Home → Browse → Sources → By Category → Statutes and Legislation → either (1) click Florida under Jurisdiction or (2) click “F” (across the top) → Scroll to FL – LexisNexis Florida Annotated Statutes → click on Table of Contents or click the down arrow then click Get Documents.

**Print Statutes**
- *Florida Statutes* (official, unannotated)
- *West's Florida Statutes Annotated* (unofficial, annotated)
- *LexisNexis Florida Statutes Annotated* (unofficial, annotated)

**Free Online Sources**
- Online Sunshine, www.leg.state.fl.us/statutes; or Florida Senate, www.flsenate.gov/Laws/Senate
  - Click Advanced legislative search and browse (to the right of the search box at the top of the page).
  - Fill in the search boxes as appropriate; click the “Find Alternate Words (stemming)” box.
  - The search engine defaults to just the titles of the statutes; to see the excerpts containing your search words, change the Document Excerpts (top right after you’ve run your search) to Short/Medium/Long, depending on your preference for the length of the excerpt.
**MAJOR SOURCES OF CASE LAW**

Virtually all case law is available online, through several different sources. Be wary, however, of citing to cases that you have retrieved from a source other than Lexis, WestlawNext, Fastcase/HeinOnline, or a court’s official website. Using Lexis or WestlawNext is preferable because these databases contain a great deal of added material, such as headnotes, citators, and linked materials. Also consult the Case Law Citations Quick Reference (on page 13) for citation information.

**Federal Case Law**

WestlawNext
- Home → Cases → Click your jurisdiction(s).

Lexis Advance
- Home → Filters → Jurisdiction, click the appropriate boxes → Category, click Cases → type search terms in the search box.
- Home → Browse → Sources → By Category → Cases → either (1) click the jurisdiction under “Jurisdiction” or (2) click the first letter of the jurisdiction (across the top of the page) → Click the jurisdiction you wish to search.
  - To search multiple jurisdictions, click “Add source as a search filter” for each jurisdiction, then type search terms in the search box at the top of the page.

Print – several different sources; see page 13 for detailed list.

**Free Online Sources**
- Google Scholar (http://scholar.google.com)
  - Case Law → Select courts → Check your jurisdiction(s) → Click Done → Type your search terms into the box → Search
- Legal Information Institute (http://www.law.cornell.edu/federal/opinions)
  - Click your jurisdiction OR click Search All Circuit Court Opinions.
  - Links you to the website for each court; coverage varies.
- Fastcase (http://www.fastcase.com/)
  - Subscription provided for free with Florida bar membership or HeinOnline access.
    - To access HeinOnline, go to the library’s webpage (http://www.law.ufl.edu/library), click Databases → HeinOnline. The Fastcase link is the far right tab.
    - You must be signed in through the VPN (http://www.law.ufl.edu/library/library-information/remote-access) to access HeinOnline.

**Florida State Case Law**

WestlawNext
- Home → Cases → Cases by State → Florida
- Home → Type “Florida cases”
Lexis Advance

- Home → Filters → Jurisdiction, click Florida; click “include related Federal Content” if needed → Category, click Cases → type search terms in the search box.
- Home → Browse → Sources → By Category → Cases → either (1) click the Florida under “Jurisdiction” or (2) click “F” (across the top of the page) → Click FL Courts of Appeals Cases or FL Supreme Court Cases.
  - To search multiple jurisdictions, click “Add source as a search filter” for each jurisdiction, then insert search terms in the search box at the top of the page.

Print

- Southern Reporter (official reporter for Florida cases).
- Florida Law Weekly (official reporter for new cases not yet published in the Southern Reporter; unofficial reporter for all others).

Free Online Sources

- Google Scholar (http://scholar.google.com)
  - Case Law → Select courts → Florida → Done → type search terms into the search box
- Fastcase (http://www.fastcase.com/)
  - Subscription provided for free with Florida bar membership or HeinOnline access.
    - To access HeinOnline, go to the library’s webpage (http://www.law.ufl.edu/library), click Databases → HeinOnline. The Fastcase link is the far right tab.
    - You must be signed in through the VPN (http://www.law.ufl.edu/library/library-information/remote-access) to access HeinOnline.
- Florida Courts’ websites (http://www.flcourts.org/)
  - Best to use when you have a citation to an opinion and need an official version; not a great search engine.
  - Links to individual court opinion websites:
    - Florida Supreme Court opinions, http://www.floridasupremecourt.org/decisions/opinions.shtml
    - First District Court of Appeals opinions, http://www.1dca.org/opinions/opinions_default.html
    - Second District Court of Appeals opinions, http://www.2dca.org/opinions/opinions.shtml
    - Third District Court of Appeals opinions, http://www.3dca.flcourts.org/Opinions/Opinions.shtml
    - Fourth District Court of Appeals opinions, http://www.4dca.org/opinions.shtml
    - Fifth District Court of Appeals opinions, http://www.5dca.org/opinions.shtml
    - County trial court information http://www.flcourts.org/florida-courts/trial-courts-county.shtml
  - For more detail about searching Florida court opinions, see page 38.
**CASE LAW CITATIONS: QUICK REFERENCE**

Case citations begin with the volume number, then the abbreviation for the reporter, then page number and date. The deciding court is sometimes indicated in parentheses.

### Federal Reporter Citations

<table>
<thead>
<tr>
<th>Court(s)</th>
<th>Reporter</th>
<th>Abbreviate</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Supreme Court (official)</td>
<td>United States Reports</td>
<td>U.S.</td>
<td>384 U.S. 436 (1966)</td>
</tr>
<tr>
<td>Supreme Court (West, unofficial)</td>
<td>Supreme Court Reporter</td>
<td>S. Ct.</td>
<td>86 S. Ct. 1602 (1966)</td>
</tr>
<tr>
<td>Supreme Court (Lexis, unofficial)</td>
<td>Lawyers’ Edition 1st &amp; 2d Series</td>
<td>L. Ed.; L. Ed. 2d</td>
<td>16 L. Ed. 2d 694 (1966)</td>
</tr>
<tr>
<td>F: federal district and appellate courts (to 1924)</td>
<td>Federal Reporter 1st, 2d, &amp; 3d Series</td>
<td>F.; F.2d; F.3d</td>
<td>489 F.3d 528 (2d Cir. 2007)</td>
</tr>
<tr>
<td>F.3d: federal appellate courts (1993–)</td>
<td>Federal Appendix</td>
<td>F. App’x</td>
<td>176 Fed. App’x 143 (2d Cir. 2006)</td>
</tr>
</tbody>
</table>

### Regional Reporter Citations

<table>
<thead>
<tr>
<th>Court(s)</th>
<th>Reporter</th>
<th>Abbreviate</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Connecticut; DC; Delaware; Maine; Maryland; New Hampshire; New Jersey; Pennsylvania; Rhode Island; Vermont</td>
<td>Atlantic Reporter 1st &amp; 2d Series</td>
<td>A.; A.2d</td>
<td>406 A.2d 624 (Md. Ct. Spec. App. 1979)</td>
</tr>
<tr>
<td>Illinois; Indiana; Massachusetts; New York; Ohio</td>
<td>North Eastern Reporter 1st &amp; 2d Series</td>
<td>N.E.; N.E.2d</td>
<td>391 N.E.2d 729 (Ohio 1979)</td>
</tr>
<tr>
<td>Iowa; Michigan; Minnesota; Nebraska; North Dakota; South Dakota; Wisconsin</td>
<td>North Western Reporter 1st &amp; 2d Series</td>
<td>N.W.; N.W.2d</td>
<td>590 N.W.2d 61 (Mich. 1999)</td>
</tr>
<tr>
<td>Georgia; North Carolina; South Carolina; Virginia; West Virginia</td>
<td>South Eastern Reporter 1st &amp; 2d Series</td>
<td>S.E.; S.E.2d</td>
<td>583 S.E.2d 780 (Va. Ct. App. 2003)</td>
</tr>
<tr>
<td>Arkansas; Kentucky; Missouri; Tennessee; Texas</td>
<td>South Western Reporter 1st, 2d, &amp; 3d Series</td>
<td>S.W.; S.W.2d; S.W.3d</td>
<td>763 S.W.2d 413 (Tex. Crim. App. 1988)</td>
</tr>
<tr>
<td>Alaska; Arizona; California; Colorado; Hawaii; Idaho; Kansas; Montana; Nevada; New Mexico; Oklahoma; Oregon; Utah; Washington; Wyoming</td>
<td>Pacific Reporter 1st, 2d, &amp; 3d Series</td>
<td>P.; P.2d; P.3d</td>
<td>649 P.2d 224 (Cal. 1982)</td>
</tr>
<tr>
<td>Alabama, Florida, Louisiana, Mississippi</td>
<td>Southern Reporter 1st, 2d, &amp; 3d Series</td>
<td>So.; So. 2d; So. 3d</td>
<td>137 So. 161 (Fla. 1931)</td>
</tr>
<tr>
<td>Court(s)</td>
<td>Reporter</td>
<td>Abbreviate</td>
<td>Example</td>
</tr>
<tr>
<td>------------------------------------------------------------------------</td>
<td>-------------------------------</td>
<td>--------------------------------</td>
<td>------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Florida Supreme Court <em>(official)</em></td>
<td>Southern Reporter 1st, 2d, &amp; 3d Series</td>
<td>So.; So. 2d; So. 3d</td>
<td>137 So. 161 (Fla. 1931)</td>
</tr>
<tr>
<td>Florida District Courts of Appeal <em>(official)</em></td>
<td>Southern Reporter 1st, 2d, &amp; 3d Series</td>
<td>So.; So. 2d; So. 3d</td>
<td>468 So. 2d 360 (Fla. 3d DCA 1985) <em>(Florida courts)</em></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>468 So. 2d 360 (Fla. 3d Dist. Ct. App. 1985) <em>(Bluebook)</em></td>
</tr>
</tbody>
</table>
MAJOR SOURCES OF ADMINISTRATIVE REGULATIONS

Administrative regulations are rules established by agencies; these agencies have been given the power by the legislature to promulgate regulations for a specific regime. Example agencies include the Internal Revenue Service and the Environmental Protection Agency.

Researching regulations often requires two parts: (1) determining which statute authorizes the agency to pass regulations; and (2) locating the regulations that apply to your factual scenario.

Federal Administrative Regulations

The three main sources of federal administrative regulations are the Code of Federal Regulations (CFR); the Electronic Code of Federal Regulations (e-CFR); and the Federal Register.

The CFR is the codification of all regulations; it is the official source of all currently in-force regulations. The CFR is updated on a rotating quarterly basis. The e-CFR is the unofficial source for currently in-force regulations and is updated daily. The Federal Register is “the daily journal of the United States government” and includes all new and proposed regulations.

Tip: Run your searches in all databases, not just WestlawNext or Lexis. Search algorithms vary widely and regulations are tricky, so an initial broad net is a useful starting point.

Start by browsing the Table of Contents or searching the Index (only in WestlawNext) – like statutes, regulations are ordered by subject.

Code of Federal Regulations & e-CFR

Official Online Version (http://purl.access.gpo.gov/GPO/LPS494)

- Maintained by the Government Publishing Office
  - Coverage: same as print version (updated on a rotating quarterly basis)
- Search tip: Click “Search Government Publications” (left side column) → click Advanced Search (right of the main search box that appears) → in the left box, click Code of Federal Regulations, then click Add → Under the “Search In” drop-down menu, select “Title,” then type keywords into search box → once your search results appear, use the “Date Published” filter on the left side to limit to the year you need (likely the most recent).
  - This will just search the title of the individual regulations, and is a good starting point if you’re unfamiliar with the CFR database.
- Remember to update any regulations that you find by locating the regulation in the e-CFR database and comparing the text.


- Maintained by the Government Publishing Office
  - Includes all currently in-force regulations (essentially the updated version of the print version)
- Search tip: Click Boolean (under Advanced Search, left column) → enter keywords into search box (next to Retrieve) → select “Section Heading” from the drop-down menu just to the right of the search box → Submit
  - This will just search the title of the headings, so it is a good starting point.

**Lexis Advance** (no index, only a table of contents)
- Coverage: Current version – updated within two weeks of publication.
- Home → Type “Code of Federal Regulations,” click Table of Contents or Get Documents.
- Home → Browse → Sources → By Category → Administrative Codes and Regulations → select either (1) U.S. Federal under Jurisdiction or (2) “C” from the list across the top of the page → scroll to CFR – Code of Federal Regulations → click Table of Contents or click the down arrow and click Get Documents.

**Westlaw Next** (includes index and table of contents)
- Coverage: Current version – updated within two weeks.
- Home → Type “Code of Federal Regulations” in the main search box
- Home → All Content → Regulations → Code of Federal Regulations

**HeinOnline**
- Coverage: same as current print version (updated on a rotating quarterly basis).
- Access through LIC website (Databases → HeinOnline)
  - http://heinonline.org/HOL/Welcome?collection=journals; use the VPN (http://www.law.ufl.edu/library/library-information/remote-access) when off-campus
  - Scroll to Code of Federal Regulations → enter citation information or click Search tab

**Official Print Version**
- Code of Federal Regulations (search the catalog)
  - If you use the print version, remember to check the Pocket Parts and the Supplements for any updates that may have occurred in the year since the print version was published.

**Federal Register**
The Federal Register is the “official daily publication for rules, proposed rules, and notices of Federal agencies and organizations, as well as executive orders and other presidential documents.”

**Official Online Version** (http://purl.access.gpo.gov/GPO/LPS1756)
- Maintained by the Government Publishing Office
- **Search tip:** Click “Search Government Publications” (left side column) → click Advanced Search (right of the main search box that appears) → in the left box, click Federal Register, then click Add → Under the “Search In” drop-down menu, select “Title,” then type keywords into search box → once your search results appear, use the “Date Published” filter on the left side to limit to the year you need (likely the most recent)
If you’re looking for specific types of documents (e.g. Notices, Proposed Rules, executive documents), follow the same procedure as list above, then scroll down to the “Section” filter on the left side, and limit to the specific type of source you need.

This just searches the title of the individual regulations so it is a good starting point.

**Lexis Advance (Table of Contents, no Index)**
- Coverage: 1936 to current – updated daily.
- Home ➔ Search “Federal Register” ➔ Click Table of Contents or Get Documents
- Home ➔ Browse ➔ Sources ➔By Category ➔ Administrative Codes and Regulations ➔ select (1) U.S. Federal under Jurisdiction or (2) “F” from the list across the top of the page ➔ scroll to Federal Register ➔ click Table of Contents or click the down arrow and click Get Documents.

**WestlawNext**
- Coverage: full text 1981-present; limited search functionality for 1936 to 1981; updated daily.
- Home ➔ Type “Federal Register” in the main search box
- Home ➔ All Content ➔ Regulations ➔ Federal Register (on right, under Tools & Resources)

**HeinOnline**
- Coverage: comprehensive, from 1936 inception. Updated daily
- Access through LIC web site (Databases ➔ HeinOnline)
  - http://heinonline.org/HOL/Welcome?collection=journa ls; sign in through the VPN (http://www.law.ufl.edu/library/library-information/remote-access) to access off-campus
  - Scroll to Federal Register Library ➔ enter citation or click Search tab

**Official Print Version**
- Federal Register (search the catalog)

**Unofficial Online Version** (http://www.federalregister.gov)
- Also maintained by the Government Publishing Office; only includes proposed rules and regulations open for public comment.
  - Aimed at the public; easier navigation and browsing, access to public comments

**Florida Administrative Regulations**
Florida administrative regulations are published in a manner similar to federal regulations. The two main sources are the *Florida Administrative Code*, which compiles Florida’s administrative rules; and the *Florida Administrative Register*, which provides notices and the status of proposed rules to the Florida Administrative Code.

**Florida Administrative Code**
Official Online Version (https://www.flrules.org)
- Maintained by the Florida Department of State, updated weekly
- **Search tip:** click “Go” underneath Advanced Search (bottom right of page)
- Check the box next to Search in Florida Administrative Code; enter keywords; scroll through the Department Name and click on any that may be relevant.
- Search All Published Issues
- If you are looking for a specific document (Proposed Rule, Variances, etc.), select that document under the “Section” box.

**Lexis Advance** (Table of Contents only, no index)
- Coverage: Current version – updated within one month of publication.
- Home → Search “Florida Administrative Code;” select Table of Contents or Get Documents.
- Home → Browse → Sources → By Jurisdiction → Florida → either (1) click “Administrative Codes and Regulations” under Category or (2) click “F” from the alphabet across the top of the page → scroll to FL – Florida Administrative Code Annotated → click Table of Contents or click the down arrow and click Get Documents.

**Westlaw Next** (Table of Contents only, no index)
- Coverage: Unclear
- Home → Type “Florida Regulations” in the search box; or Home → Regulations → Florida

**Official Print Version**
- Florida Administrative Code (search the catalog)

**Florida Administrative Register** (formerly Florida Administrative Weekly):

**Official Online Version** (https://www.flrules.org)
- Maintained by the Department of State, updated daily
- **Search tip:** click “Go” underneath Advanced Search (bottom right of page)
  - Check the box next to Search in Florida Administrative Register; enter keywords; scroll through the Department Name and click on any that may be relevant
  - Search All Published Issues
  - If you are looking for a specific document (Proposed Rule, Variances, etc.), select that document under the “Section” box.

**Lexis Advance** (Table of Contents only, no index)
- Coverage: 1996-2012
- Home → type Florida Administrative Weekly into main search box
- Home → Browse → Sources → By Jurisdiction → Florida → Administrative Codes & Regulations (on left, under Category) → Florida Administrative Weekly → Get Documents or Table of Contents
- Make sure to confirm regulation status through official online version.

**Westlaw Next** (no Table of Contents or Index)
- Coverage: unclear
- Home → Proposed and Adopted Regulations → Florida
- Make sure to confirm regulation status through official online version.
USING CITATORS

Basic Citator Information

What is a citator?
At its core, a citator is an index of legal materials. With a citator service, a legal researcher can generate a list of material that cites to a specific source or document. The two primary legal citators are KeyCite (WestlawNext) and Shepard’s (Lexis Advance).

Bloomberg Law also has a citator, BCite.

Why should I use a citator?
Citators help you to:

- Determine whether a primary law source, such as a case or a statute, is still valid law.
- See the effect a citing document has on a case or a statute (positive, negative, affirm, overturn, question, etc.), and see the depth of treatment the citing resource gives to that case or statute.
- Expand a primary source by using that source to find additional relevant primary and secondary sources.
- Limit citing resources by headnote (point of law), jurisdiction, date, and other categories.
- See the appellate history of a case.

What types of sources does a citator serve?
KeyCite (WestlawNext) and Shepard’s (Lexis Advance) provide citator services for different materials:

- Shepard’s: cases, statutes, the CFR, select administrative decisions, and law journals
- KeyCite: cases, statutes, administrative decisions, federal regulations, and law journals

Using the Shepard’s Citator in Lexis Advance

If you know the citation for the document you want to Shepardize:

- In the search bar, type shep: proper Bluebook cite

To Shepardize when in a document:

- Once you have located a document, click “Shepardize”
  - The link is usually at the top of the document
  - Some types of documents also have a “Shepard’s Report” link on the right.
  - Remember that different types of documents have different citator information available.
Shepardizing Cases

- On the right hand side of the screen, you will see a shorthand Shepard’s:

  ![Shepard's Screenshot]

  - Click Shepardize this document to get the full history.
  - On the top right of the screen that opens, you will see:

    - **Appellate History**: prior and subsequent history of the case.
    - **Citing Decisions**: all of the cases that cite to the case.
    - **Other Citing Sources**: all of the law reviews, treatises, annotations, and other secondary sources that cite to the case.
    - **Table of Authorities**: the list of cases cited by the case.

The signal next to Citing Decisions shows you the status of the case you are Shepardizing (see below, page 26 for the definition of the Signals). Clicking on Citing Decisions or Other Citing Sources, you have the chance to further filter the results.

**Citing Decisions** allows you to expand your cases. Narrow By:

- Analysis (warning; questioned; caution; positive; neutral)
- Court (both state and/or federal)
- Discussion (how much the citing decision considers the case)
  - Analyzed: fully considers the case
  - Discussed: some analysis of the case
  - Mentions: brief mention of the case
  - Cited: cites to the case with minimal if any discussion
- Headnotes (if the citing case cites to a specific headnote)
- Search terms within the results
- Timeline (limit to a specific date)
Other Citing Sources provides different filtering options:

- Content (law review; court document; treatise; statute; annotation; secondary sources)
  - Note: depending on the citing sources, there will be different filters
- Search terms within the results
- Timeline (limit to a specific date)

Shepard’s Signals for Cases
Shepard’s Signals indicate the treatment that the case has been given by other cases and allow you to update a case. The signals are defined as follows:

- **Warning**: Negative treatment is indicated for your case.
  - Citing references contain strong negative history or treatment for at least one point of law of your case (for example, overruled by or reversed).
  - **Warning DOES NOT automatically disqualify a case from use**. If the citing reference is **from a binding jurisdiction**, read it to see if and how your point of law is affected.

- **Questioned**: Validity questioned by citing reference.
  - Citing references contain treatment that questions the continuing validity or precedential value of your case because of intervening circumstances, including judicial or legislative overruling.
  - If the citing reference is **from a binding jurisdiction**, read it to see how your case has been impacted.

- **Caution**: Possible negative treatment indicated.
  - Citing references contain history or treatment that may have a significant negative impact on your case (for example, limited or criticized by).
  - If the citing reference is **from a binding jurisdiction**, read it to see how your case has been impacted.

- **Positive treatment indicated.**
  - Citing references contain history or treatment that has a positive impact on your case (for example, affirmed or followed by).

- **Citing references with analysis available.**
  - Citing references contain treatment of your case that is neither positive nor negative (for example, explained).

- **Citation information available.**
  - Citing references are available for your case, but the references do not have history or treatment analysis (for example, the references are law review citations).
Shepardizing Statutes

- Just as with cases, the Shepard’s Report link will be near the top of the statute or just to the right.
- When you Shepardize a statute, you will see this information:

- Unlike cases, statutes have only one signal:
  - citing references contain strong negative treatment of the Shepardized section (for example, the section may have been found to be unconstitutional or void)

The Citing Decisions and Other Citing Sources for statutes can be filtered in the same manner as for cases. See above p. 21.

Using the KeyCite Citator in WestlawNext

Each document will have the KeyCite information in tabs at the top of the screen. These tabs will vary by document type.

KeyCiting Cases

The following tabs appear at the top of a case:

- **Filings**: briefs, records, motions, etc. available for the case
- **Negative Treatment**: cases that have negatively referenced your case
  - *Note*: the signals next to the cases in this list indicate the citing case’s status, not the status of your case, the cited case
- **History**: previous cases (i.e., trial or district court opinions) and subsequent cases
  - Once in History, you may have the option to filter by:
    - All History;
    - Principal History (the important direct history of the cited case; excludes non-dispositive history such as grants of certiorari or review, cases that were consolidated on appeal, etc.);
    - Previous History (all direct previous history of the cited case);
    - Subsequent History (cases decided on remand, after the cited case).
- **Citing References**: all references (cases, secondary sources, court documents, etc.) that cite to your case.
Once you click on Citing References, you have the option to further filter Citing References by:

- Cases; Trial Court Orders or Documents;
- Administrative Decisions & Guidance;
- Secondary Sources;
- Appellate Court Documents;

Once you’ve filtered to a specific type of document, you will have further filtering options that will vary by type of document.

- Examples: Jurisdiction (state and/or federal);
- Depth of treatment (how much the citing case analyzes the cited case);
  - : extended discussion (more than a page)
  - : substantial discussion (more than a paragraph)
  - : some discussion (less than a paragraph)
  - : brief reference or citation only
- Headnote topics;
- Date;
- Publication name

**Table of Authorities:** all cases **cited by** the case that you are viewing

- Information includes:
  - Treatment of the cited case
  - Depth of treatment of the cited case
  - Whether your case quoted the cited case
  - The page number cited by your case.

**KeyCiting Statutes**

The following tabs appear at the top of a statute:

- **Notes of Decisions:** selected cases grouped by topic; provide in-depth analysis of the statute section
- **History:** legislative history of the statute, including enacting legislation and amendments.
- **Citing References:** just as with cases, all references (cases, secondary sources, court documents, etc.) that cite to the statute.

Once you click on Citing References, you have the option to further filter Citing References by:

- Cases or Trial Court Orders or Documents;
- Statutes; Regulations; or Administrative Decisions & Guidance;
- Secondary Sources;
- Appellate Court Documents; etc.
Once you’ve filtered to a specific type of document, you will have further filtering options that will vary by type of document.

- Examples: jurisdiction (state and/or federal); referenced in Notes of Decisions; Notes of Decisions topics; date; publication name; etc.
- This allows you to expand the statute to find additional, relevant cases.

**Context & Analysis:** in-depth cross references with other statutes or regulations; law review commentaries; ALRs & treatises; and other secondary sources.

- Similar to Citing References, you have the option to further filter by type of document:
  - Cross References (e.g. other statute sections); or the CFR;
  - Law Review Commentaries (e.g. law review articles that discuss the statute);
  - Library References (CJS links and KeyNumbers associated with the statute section);
  - Other secondary sources (e.g., ALR, Encyclopedias, Treatises & Practice Aids)
- Unlike with the other filters, once you have limited to a specific type of documents, you do not have additional filter choices. Instead, you are provided with links to the specific documents.
- **Note:** not all types of documents will appear for each statute – it depends on whether the statute has been cited by that type of reference.

**Signals in WestlawNext**

Each document in WestlawNext is assigned a signal to make it easy to identify a document’s status. These signals appear in the top left of the document, next to the case citation or the statute citation.

### No longer good law for at least one point of law

- A red flag indicates that a court has overruled a case, vacated a judgment, held a statute unconstitutional, etc. – in some way, the statute or case is no longer valid.
- **DOES NOT automatically disqualify a case or statute from use.** If the citing reference is from a binding jurisdiction, read it to see if your point of law is affected and if so, how.

### Some negative treatment

- A yellow flag indicates a document has some negative treatment but hasn’t been overruled or reversed (e.g., negative reference, proposed legislation).
- If the citing reference is from a binding jurisdiction, read it to see how your case has been impacted.

### Case appealed

- A blue-striped flag indicates a document has been appealed to the U.S. Courts of Appeals or the U.S. Supreme Court (excluding appeals originating from agencies).
USING HEADNOTES

General Information about Headnotes

What are Headnotes?
Headnotes are an indexing system for case law. Discrete legal concepts are identified within a case. That discrete legal concept is assigned a designation, which then allows a researcher to find all cases with that specific designation.

WestlawNext’s predecessor began indexing case law concepts in the late nineteenth century, resulting in what is now the West Topic and KeyNumber system. In the West system, Topics constitute large areas of law, such as Constitutional Law. Within each topic, discrete legal concepts are identified, then assigned a number. Most topics contain several subtopics, which allows a researcher to drill down through the system to identify the most relevant KeyNumber.

Lexis also provides a headnote system for cases, but its indexing schema is much more limited than that of WestlawNext.

Example: West’s Headnote Constitutional Law k1053 (Strict or Heightened Scrutiny: Compelling Interest) will pull all cases that West’s editors have identified as containing that discrete legal concept.

Example: The 11th headnote in Roe v. Wade states “Where certain fundamental rights are involved, regulation limiting these rights may be justified only by a compelling state interest and the legislative enactments must be narrowly drawn to express only legitimate state interests at stake.” This statement is assigned to the topic of constitutional law and the key number 1053 (Strict or heightened security: Compelling interest), generally written as “Constitutional Lawk1053.”

Why should I care about headnotes?
Headnotes are an extremely useful system for researchers because they:

- Tell you what is discussed in a case.
- Link you to the discussion in the case so that you can read the legal concept in context.
- Help you expand your research by linking you to other cases with that same legal concept, allowing you to easily find relevant materials.
- Allow you to restrict your Shepard’s/Keycite report by legal concept, thus helping you narrow the cases that you really need to read to validate your case.

Headnotes and the indexing system EXPAND and UPDATE primary sources.

Using Headnotes in WestlawNext

- Once you have located a promising case, open it and read the headnotes at the top of the case. If the legal concept for which you are looking is in the headnotes, use the headnote (click the number to the left of the Headnote text) to navigate to the section of the case where it is discussed to determine if the case is relevant.
  - There are two views for Headnotes. Choose the one you prefer:
Once you have decided the case is relevant, **read the case in its entirety**. You should never depend on the headnotes when citing to a case. If you have not read the entire case, do not cite/use it.

**Expanding a case using a relevant headnote.**

There are three methods to expand your research using a headnote in WestlawNext.

**Method One:**
- Click on one of the Topics/subtopics to locate all cases related to this legal issue.
The Topics are organized from broadest to narrowest. Typically, clicking on the broadest topic (above, Federal Courts, Key 170B) will provide you with more cases than clicking on one of the narrower subtopics (such as Review of Federal District Courts, Key 170Bk3149).

After clicking on the Topic/subtopic, you will be taken into the Westlaw Key Number system, and provided with a list of all cases that the West editors have indexed under that discrete point of law, within the specified jurisdiction.

You can either:
- Filter the cases by changing the jurisdiction (right under the topic and key word, at the top of the page):
- Or you can search by keyword using the Search within results box on the left hand side of the screen.

Once you have filtered the cases, read through them to determine if any are relevant.
- Make sure that you update any cases that you deem relevant using KeyCite.
- Find additional relevant cases by following the same procedure for different headnotes or narrower/broader subtopics within the same headnote.

Method Two:
- Click on the “# Cases that cite this headnote,” which will pull up the cases that cite to your case for the specific legal concept embodied by the headnote:

You will be taken into the Citing References tab. The list of cases that comes up is every case that cites to your case for the proposition of law contained in the headnote you clicked.
- Use the filters on the left hand side to further limit results, if needed. Filters include:
  - Keyword search within the citing cases
  - Jurisdiction of the citing cases
  - Date of the opinions of the citing cases
  - Depth of Treatment (how much analysis the citing case provides to your cited case; not headnote specific)
  - Treatment status (limit to either only negative cases or all cases that are not negative; not headnote specific)
  - Reported status (limit to either reported or unreported cases)
- Once you have filtered the cases, read through them to determine if any are relevant.
  - Make sure that you update any cases that you deem relevant using KeyCite.
  - Find additional relevant cases by following the same procedure for different headnotes.

Method Three:
- Click on Citing References > Cases
- Filter the cases to specific Headnote Topics:
  - Scroll down to Headnote Topics (on the left) and click the boxes for the most relevant headnotes, then click Apply Filters; or
  - Look at the headnote numbers listed in the far right column and choose cases that cite to your specific headnote. Hover over the headnote number to see the full text of the headnote
- Use the filters on the left hand side to further limit results, if needed. Filters include:
  - Keyword search within the citing cases
  - Jurisdiction of the citing cases
  - Date of the opinions of the citing cases
  - Depth of Treatment (how much analysis the citing case provides to your cited case; not Headnote specific)
  - Treatment status (limit to either only negative cases or all cases that are not negative; not headnote specific)
  - Reported status (limit to either reported or unreported cases)

Updating a case using KeyCite:
- Before you can cite to a case, you must make sure that the point of law you wish to cite in the case is still good law.
- Open the case you wish to cite.
  - Click Citing References > Cases
  - Under Jurisdiction (left column), click all jurisdictions that are binding in your jurisdiction/for your fact pattern
  - Under Treatment Status (in the left column), click View Negative Only.
  - Click Apply filters.
- Skim through each of the negative cases to determine how it impacts the case you wish to cite.
Tip: Once you click into a case, click the green right arrow next to Search term. This will take you directly to the part of the case that cites to the case that you are updating:

If the citing case does not discuss the point of law from the case that you wish to cite, you can cite the case.

Using headnotes in Lexis Advance
The Lexis Advance headnote system is not quite as developed as WestlawNext and does not have as detailed an indexing system. Additionally, while WestlawNext uses human indexed terminology, Lexis relies on an algorithm to develop their headnote system. For these two reasons, headnotes will be different between the databases.

Once you have located a promising case, open it and read the headnotes at the top of the case. If the headnotes indicate that there is a relevant legal concept discussed in the case, click the blue down arrow next to the headnote to navigate to the section of the case where it is discussed.

If, after skimming the part of the case applicable to the headnote, you decide the case is relevant, **read the case in its entirety.** You should never depend on the headnotes when citing to a case. If you have not read the full case, do not cite/use it.

Expanding a case using Lexis Headnotes
Method One

- This method narrows a case by a specific, discrete legal topic.
- Click on the arrow next to the word or phrase in the string of topics that is most relevant to your research and select Get Documents. Like with WestlawNext’s Headnotes, Lexis’s Headnotes are organized from broadest to narrowest. You will get all of the cases that are categorized by Lexis’s algorithm in that topic:

The “. . .” signifies that there are additional topics between the broad topic *Civil Procedure* and the narrower topic *Justiciability.*

Click on any down arrow to get cases indexed under that topic.

Indicates that a Topic Summary Report is available. The Summary report contains a wide variety of information about the specific topic, such as definitions, seminal cases, elements, burden of proof, etc.
After clicking Get Documents, you can use the column on the left to further filter by:

- **Type of Document:**
  - Cases
  - Statutes & Legislation
  - Administrative Codes & Regulations; or Administrative Materials
  - Secondary Materials; Forms; Briefs, Pleadings & Motions
  - and many more.

Once you’ve selected a specific type of source, you can apply additional filters (options vary by type of source). Some possible filters are:

- Search Within Results
- Jurisdiction (state and/or federal; court)
- Timeline (date of opinion)
- Reported/Unreported
- Most Cited
- Keyword

**Method Two**

- This method uses the headnotes to narrow your citing references by Shepardizing a specific headnote.
- Find a relevant headnote. Click on *Shepardize – Narrow by this Headnote*:

  Constitutional Law > … > [Case or Controversy] > [Standing] > [General Overview]

  **HNA** Absent harassment and bad faith, a defendant in a pending state criminal case cannot affirmatively challenge in federal court the statutes under which the state is prosecuting him. *Shepardize – Narrow by this Headnote*

- This will bring up a list of citing decisions in which the legal concept embodied by that headnote (here, headnote 4) appear.
- You can then further narrow the results by using the filters in the left column:
  - Analysis (warning; questioned; caution; positive; neutral)
  - Court (both state and/or federal)
  - Discussion (how much the citing decision considers the case)
    - Analyzed: fully considers the case
    - Discussed: some analysis of the case
    - Mentions: brief mention of the case
    - Cited: cites to the case with minimal if any discussion
  - Search terms within the results
  - Timeline (limit to a specific date)
Method Three
Use the Shepard’s Report.

- Click on Shepardize this document:

  **Roe v. Wade, 410 U.S. 113**

  *Supreme Court of the United States*

  December 13, 1971, Argued ; January 22, 1973, Decided

  No. 70-18

  **Reporter**

  410 U.S. 113 | 93 S. Ct. 705 | 25 L. Ed. 2d 147 | 1973 U.S. LEXIS 159

  **ROE ET AL. v. WADE, DISTRICT ATTORNEY OF DALLAS COUNTY**

  **Subsequent History:** Reargued October 11, 1972.

  - Click on Citing Decisions; then, under Narrow By (left column), click the Headnote(s) that are relevant to your case.

Updating a case using Shepard’s

- Before you can cite to a case, you must make sure that the point of law you wish to cite in the case is still good law.
- Open the case you wish to cite.
- Click on Shepardize this document (see above, under Method Three).
- Under Narrow By > Analysis, select Warning, Questioned, and Cautioned
  - **Tip:** to select multiple Analysis filters at one time, click “Select multiple” (just above Court), check all that apply (Warning, Questioned, Cautioned), then click OK.
- Under Narrow By > Court, select all jurisdictions that are binding in your jurisdiction/for your fact pattern.
  - **Tip:** to select multiple jurisdictions at one time, click “Select multiple” (underneath either the federal and state courts), check all that apply, then click OK.
  - These filters limit the results to just binding cases that have negatively referred to your case.
- Skim through each of the negative cases to determine how it impacts the case you wish to cite.
  - **Tip:** Lexis will open the citing case to the first point where your case appears. Be wary, because the first point where your case appears may be in the Syllabus or Headnotes, not in the opinion itself.
  - If the citing case does not discuss the point of law from the case that you wish to cite, you can cite the relevant case.
SEARCHING: TERMS & CONNECTORS (BOOLEAN) v. NATURAL LANGUAGE

WestlawNext, Bloomberg, Lexis, and many other databases provide two different options for searching: Terms & Connectors and natural language. Each database has a different search algorithm, which means that the databases “read” natural language, and terms and connectors, differently.

By understanding how each search engine uses Terms & Connectors and, generally, the order in which words are searched in the individual databases, you can start to construct more elaborate search strings. This will give you more precise search results.

What is Terms & Connectors (T&C) Searching?

- T&C searching is a form of searching that utilizes specific symbols or words to indicate to the search algorithm how the words should be connected, or searched, within the database.
- T&C searching is often called Boolean searching; the connectors that you use (such as and, not, or) are called Boolean operators.
- Using T&C, results tend to be more precise than when using a natural language search.
- When you run a T&C search, you are overriding the usual order of operations for the search.
  - Examples of T&C searches: (note: the T&C will differ by database. These examples use WestlawNext’s T&Cs):
    1. (Larry /3 Flynt) AND “intentional infliction of emotional distress” BUT NOT (Howard /3 Stern)
       - *Tells the database to search for a document in which the word “Larry” is within 3 words of “Flynt,” that also has the phrase “intentional infliction of emotional distress” but that does not have the term “Howard” within 3 words of “Stern”*
    2. (“dog bite” /s child!) /p landlord
       - *Tells the database to search for a document in which “dog bite” and child appear in the same sentence and the sentence in which “dog bite” and child appear is also in the same paragraph as the word landlord.*
- T&C’s can be made more powerful by using parentheses.
  - Searches with T&Cs are run through a specific order; when you use parentheses, you force the database to conduct the search in a different order (essentially, you are distributing search terms through the parentheses, reminiscent of algebra).
Examples:
1. contract AND “meeting of the minds” OR agreement
   - Finds documents that have both contract and “meeting of the minds”
   - PLUS documents that just have the word agreement

2. contract AND (“meeting of the minds” OR agreement)
   - Finds documents that have (1) contract and “meeting of the minds” and
     (2) contract and agreement

What databases use Terms and Connectors (T&C)?
Most, but not all, databases and search engines currently default to natural language searching. You can often override the natural language and switch to T&C either by knowing the terms and connectors for that database or by using the advanced search function.

Legal databases currently have the following defaults:
- Bloomberg Law (T&C default; no natural language)
- Lexis Advance (Natural Language default; use Advanced Search)
- WestlawNext (Natural Language default; use Advanced Search or Boolean operators)

When should I use Terms and Connectors?
- When your initial natural language search fails
- When you can make an educated guess as to placement or number of keywords in potentially relevant documents
  - E.g., ATLEASTFIVE(“right to privacy”) finds only documents in which the phrase “right to privacy” appears at least five times – thus eliminating those documents that just mention the right to privacy in passing
  - E.g., generic /s drug!, finds only documents in which generic appears in the same sentence as drug or drugs, thus eliminating documents in which “generic” means ordinary, as well as catching documents with sentences such as “these drugs, all generic, were manufactured by . . .”
When you can make an educated guess as to where keywords will appear in the document
  - E.g., use segment searches such as SY (synopsis) or DI (digest) – these limit your search to just the synopsis or digest of a case. If you have good, relevant keywords, chances are that they will appear in the synopsis or digest (headnotes) of a case.

What connectors should I use?
  - All databases use different connectors. Use the links below (may require password); find the Help page for the database; or Google “search terms <database.>
    - Lexis Advance - http://goo.gl/9x8XDI

What is Natural Language Searching?
  - Natural language is a more flexible form of database searching than T&C.
  - With natural language searching, you search using language that is similar to the way that you speak.
    - E.g., number of attorneys in Florida
    - The program’s algorithm will then try to interpret how the included words should be related to one another.
    - No special characters or terms are needed.
    - Google is the best example of a natural language dominant search engine.

What databases use Natural Language searching?
Most, but not all, databases and search engines currently default to natural language searching; both WestlawNext and Lexis Advance default to natural language. HeinOnline and Bloomberg do not, requiring you to use T&C.

When should I use Natural Language searching?
  - When you are not sure where to start and need to figure out the terms of art and keywords.
  - When you are searching abstract or conceptual ideas.
  - When you want a large set of materials to sift through and filter.
What is a finding aid?
A finding aid is a tool that helps you locate relevant material. Finding aids include indexes, tables of contents, tables of cases, and tables of laws.

How do you use finding aids?
Each publication will have its own unique finding aid, tailored to that source. For instance, Chemerinsky’s Constitutional Law: Principles and Policies hornbook includes a table of contents, a table of cases, and an index. Finding aids will vary by publication.

The following pages discuss the characteristics and guidance for using four types of finding aids.

**Index**

**Index Characteristics:**
- Alphabetical arrangement of information, often organized by subjects or names.
- Indicates where to locate information within the main text of the publication.
- Usually includes controlled vocabulary to assist in determining terms of art used by the publication.
  - Example: Zone of interest test. See Standing.
  - Directs you to the phrasing used by the publication.

**Index locations:**
- In a single volume, usually at the back of the publication. In a multi-volume set, usually in the last volume.
- Some databases also include indexes:
  - In Westlaw, finding aids often appear on the right side of the screen.
  - In BNA/Bloomberg, the index is typically at the bottom right or left corners of the page.

**How to use an index:**
- Look through the index for the keywords or topics that you included in your research plan; consult a thesaurus for synonyms if you don’t have any luck.
- When you find a relevant subject, you will be given either the location of the subject in the publication; or a cross-reference to another portion of the index (e.g., if you look up “children,” you may find “See Infants, this index.” You then will look up Infants in the index.).
- Read the sections indicated.
- If you are using an index in a database like Westlaw, you can often browse or search the index. The online indexes function similarly to the print: locate a relevant topic, find a citation to a place in the book or a cross reference, then click the link.
Table of Contents

Table of Contents Characteristics:

- Chronological list of all of the major sections of a publication, in the order in which they are printed, which indicates the location of the sections in the publication.
- A publication may include a brief overall table of contents and a more detailed table of contents.

Table of Contents locations:

- Generally at the beginning of a publication.
- Large multivolume publications may have tables of contents in one or more of the following places: in the front of the first volume, in the front of each volume, and/or in the front of each major section or topic.
- Some databases include tables of contents. The locations vary by database.
  - Lexis Advance: view the table of contents through the browse sources function.
  - Westlaw: typically on the top right side of the screen when you click on a publication, e.g., USCA.
  - Both Lexis Advance and Westlaw have a table of contents for statutes and treatises. The table of contents will be an option at the top of the screen.

How to use a Table of Contents:

- Browse through the table of contents to locate the subject which you are researching. You may be able to find related topics this way, too.
  - Example: when researching a statute, use the table of contents to look at surrounding statutes, which are often related to your initial statute.
  - In Westlaw and Lexis, search just a source’s Table of Contents to find relevant sections.

Table of Cases & Table of Laws

Table of Cases & Table of Laws Characteristics:

- Alphabetical list of judicial opinions; or numerical or alphabetical list of statutes or regulations, discussed within the publication.
- Indicates where the discussion of the primary law takes place within the publication.
- Often lists a case by both plaintiff and defendant.
- Sometimes alternatively arranged by jurisdiction, date, or topic.
- Good sources for major cases, statutes, or regulations in a particular area of law.

Table of Cases & Table of Laws locations:

- If included, generally at the end of the publication.
- Rarely found in a database.

How to use a Table of Cases or Table of Laws:

- Look up a case name by plaintiff or defendant.
- Look up a statute or regulation by citation or Title number.
- For tables arranged by jurisdiction, date, or topic, locate the jurisdiction, date, or topic relevant to your issue; skim the publication’s discussion of those primary sources.
OTHER RESEARCH RESOURCES

Print materials
- Check the law firm library (if there is one); in lawyers’ offices; or a local county or academic law library. WashLaw maintains a list of law libraries at www.washlaw.edu/statecourtcounty/.

Bloomberg Law (http://www.bloomberglaw.com; requires password)
- Exclusive provider of PLI and BNA materials.
- Best resource for (1) federal dockets and some state dockets; (2) corporate law research; (3) basic tax research.
- Free summer access for any purpose and 6 months free access after graduation

Fastcase (http://www.fastcase.com; access provided for free to members of the Florida Bar)
- Caselaw research database; linked to HeinOnline for seamless journal searching
- Access via LIC Website (http://www.law.ufl.edu/library/ > Databases); must be logged in through the VPN (http://www.law.ufl.edu/library/library-information/remote-access)).

FDsys (http://www.gpo.gov/fdsys)
- Official U.S. government document portal
- Find statutes, regulations, congressional documents, executive documents, and some case law.

Congress.gov (http://www.congress.gov)
- Congressional resource for legislation and congressional record.
- Includes pending legislation, public laws, committee and member information, and some historical legislative information.

Legal Information Institute (http://www.law.cornell.edu)
- Statutes, regulations, and select Supreme Court cases;
- Wex, a quality controlled, a free online legal dictionary/encyclopedia.

Google Scholar (http://scholar.google.com)
- Searches for cases and scholarly articles; good starting point before jumping into paid databases.
  If logged in via the VPN, access to journal articles is seamless.

Municode (http://www.municode.com)
- Best starting point for municipal (e.g. city or county) ordinances from across the country.
- Not comprehensive; try the city or county webpage to verify or for additional information.

State websites
- Most states now publish their statutes, Regulations, opinions, etc., online. The quality and search functionality of these websites varies considerable, but are always worth checking out.
- For detailed information about Florida state websites, see page 39.
FREE SOURCES OF LAW ONLINE

There are several free online sources; these two pages document the best places to start. For a more comprehensive guide to free online sources, visit the Free and Low Cost Legal Research Guide at http://guides.law.ufl.edu/free_research.

Remember: All primary materials must be updated using print resources, Lexis, or WestlawNext.

### Free Federal Materials

<table>
<thead>
<tr>
<th>Material</th>
<th>Sources</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>    - Click case law &gt; select courts &gt; choose jurisdiction(s) &gt; done.</td>
</tr>
<tr>
<td></td>
<td>    - Search by citation or keyword</td>
</tr>
<tr>
<td></td>
<td>    - For advanced search tips, see Google’s advanced search page (</td>
</tr>
<tr>
<td></td>
<td>    <a href="http://tinyurl.com/l8t46r">http://tinyurl.com/l8t46r</a>) and the page the details the search</td>
</tr>
<tr>
<td></td>
<td>    operators that Google recognizes (<a href="http://tinyurl.com/pdlvycf">http://tinyurl.com/pdlvycf</a>)</td>
</tr>
<tr>
<td></td>
<td>    - Although these pages only mention Google, the same principles</td>
</tr>
<tr>
<td></td>
<td>    apply to Google Scholar.</td>
</tr>
<tr>
<td>Federal Statutes</td>
<td>- Cornell Legal Information Institute (LII), <a href="http://www.law.cornell.edu/">http://www.law.cornell.edu/</a></td>
</tr>
<tr>
<td></td>
<td>    uscode/text</td>
</tr>
<tr>
<td></td>
<td>    - Most useful free version; unofficial</td>
</tr>
<tr>
<td></td>
<td>    - Searchable &amp; browsable</td>
</tr>
<tr>
<td></td>
<td>    - To search, type your keywords in the search box in the top right</td>
</tr>
<tr>
<td></td>
<td>    of the website, then limit to U.S.C. using the filters on the left.</td>
</tr>
<tr>
<td></td>
<td>    - If you like, you can also further limit by Title</td>
</tr>
<tr>
<td></td>
<td>    - Each section includes a Notes tab with the section source,</td>
</tr>
<tr>
<td></td>
<td>    amendments, and cross-references.</td>
</tr>
<tr>
<td>Administrative Regulations</td>
<td>- FDsys, <a href="http://www.gpo.gov/fdsys">www.gpo.gov/fdsys</a></td>
</tr>
<tr>
<td></td>
<td>    (click Code of Federal Regulations, right side of the screen)</td>
</tr>
<tr>
<td></td>
<td>    - Most current version; but unofficial.</td>
</tr>
<tr>
<td>United States Constitution</td>
<td>- Regulations.gov</td>
</tr>
<tr>
<td></td>
<td>    - User-friendly</td>
</tr>
<tr>
<td></td>
<td>    - Best for proposed regulations &amp; public comments</td>
</tr>
<tr>
<td></td>
<td>- Congress.gov</td>
</tr>
<tr>
<td></td>
<td>    - Search current legislation, the Congressional Record, Public</td>
</tr>
<tr>
<td></td>
<td>    Laws, etc.</td>
</tr>
<tr>
<td></td>
<td>    - Contains bills, committee reports, floor debates</td>
</tr>
<tr>
<td></td>
<td>    - Date of coverage varies; use the Resources and Help links</td>
</tr>
<tr>
<td></td>
<td>- FDsys, <a href="http://www.gpo.gov/fdsys">www.gpo.gov/fdsys</a> (click Constitution of the USA, right side</td>
</tr>
<tr>
<td></td>
<td>    of the screen)</td>
</tr>
<tr>
<td></td>
<td>    - Includes analysis written by the Congressional Research Service,</td>
</tr>
<tr>
<td></td>
<td>    historical notes, and case annotations through 2014.</td>
</tr>
</tbody>
</table>
Free Florida State Materials

Case Law: Florida Supreme Court

- Google Scholar, scholar.google.com
- Florida Supreme Court opinions (1999-present), www.floridasupremecourt.org/decisions/opinions.shtml
  - Official site; does not have a search function
  - To search, go to FSU’s archive of Florida Supreme Court opinions (http://archive.law.fsu.edu/library/flsupct/index.html), then return to the Florida Supreme Court’s page to get the official opinion.
  - Watch oral arguments and get the transcripts (http://www.wfsu.org/gavel2gavel/index.php) from the Florida Supreme Court (archived back to 1997).

Case Law: Florida District Courts of Appeal

- Only the 5th DCA’s website offers a search engine for its opinions.
- To search for DCA opinions, use:
  - Google Scholar (see above for search tips and how to narrow by jurisdiction)
  - Fastcase (https://apps.fastcase.com/Research/Pages/Start.aspx ) (must be logged in through the VPN or access for free with a Florida bar membership)
    - Click advanced caselaw search (to the right above the search box) > individual jurisdictions (left column, middle of the screen) > state supreme and appeals courts > click Florida > type search string into search box.
  - Public Library of Laws (http://www.plol.org/Pages/Search.aspx) (backed by as Fastcase; opinions back to 1997)
  - Findlaw (http://caselaw.findlaw.com/court/fl-district-court-of-appeal#casesearch2 ) (free text search only; opinions back to 1997).
    - Enter your search string; look at the first number in the docket number to determine which DCA a case is from (example: No. 2D-13-012 is from the 2nd DCA).
- After you’ve found a case, go to the appropriate DCA website (linked below) to get the official version of the case.
- The DCAs organize their opinions by release date. This date should appear near the beginning of the opinion, under the case name and citation. Click into the appropriate DCA website, then click Archived Opinions, then scroll to the release date.
  - 1st District Court of Appeal opinions (2003-present), www.1dca.org/opinions
  - 2nd District Court of Appeal opinions (2001- present), www.2dca.org/opinions/opinions.shtml
  - 3rd District Court of Appeal opinions (2001- present), www.3dca.flcourts.org/Opinions/Opinions.shtml
  - 4th District Court of Appeal opinions (2005- present), www.4dca.org/opinions.shtml
  - 5th District Court of Appeal opinions (2001- present), www.5dca.org/opinions.shtml
Florida Statutes
- Florida Statutes (current version): www.leg.state.fl.us/Statutes
  - Click Advanced legislative search and browse (to the right of the search box at the top of the page)
  - Fill in the search boxes as appropriate; click the “Find Alternate Words (stemming)” box
  - The search engine defaults to just the titles of the statutes; to see the excerpts containing your search words, change the Document Excerpts (top right after you’ve run your search) to Short/Medium/Long (depending on your preference).

Administrative Regulations (Florida Administrative Code (FAC) and Florida Administrative Register (FAR))
- www.flrules.org/Default.asp is the best resource for both the FAC & the FAR.
  - The website also searches Notices in the FAR.
  - Click “Go” (bottom right, underneath Advanced Search)
  - Select either the FAC or the FAR (or both)
  - Select the department (that wrote/administers the rule) if you know it
  - Once you select a department, you can choose a division, if you know it
  - At the bottom of the page, make sure that you change the dates to reflect more than one year to capture all of the regulations.
  - The website can also be used to search Notices in the FAR.

Legislative Materials
- Florida Constitution (current), www.leg.state.fl.us
- Senate Documents, www.flsenate.gov
  - House and Senate documents include bill summaries, introduced bills, fiscal analyses, journals, and legislative reports
GENERAL RESEARCH TIPS

If you have too much information:

- You probably have not framed your issue narrowly enough.
- Return to your assignment or the original legal question.
  - Be more specific in identifying the legal issue.
    - E.g., negligence instead of torts
  - Consider whether there are jurisdictional considerations that you have not yet applied.
  - Can you split the question into parts/sub-issues that can be tackled one at a time?
    - E.g., procedural issues v. substantive law.
  - Clarify the assignment with the attorney who gave it to you. The attorney may be able to provide more specific details.

If you don’t have enough information:

- Broaden the types of resources that you are looking at:
  - Have you looked through multiple types of secondary sources?
  - Did you look at all of the resources mentioned in the annotations to the statutes?
  - Did you look at all applicable primary sources (statutes, cases, regulations, etc.)?
  - Consider expanding your search into a different jurisdiction, if you are sure no information exists in your jurisdiction.
- Broaden the legal topic you are researching:
  - Be less specific in the legal issue.
    - E.g. general duty of care instead of duty to warn of danger on property
  - Focus less on the facts and more on the legal theory.
    - E.g. liability for wild animal bite instead of liability for raccoon bite
- Every once in a while, you may be researching a case of first impression for your jurisdiction.
  - There may not always be a definitive answer to every research question.
  - If you cannot find an answer, ask for help from your supervising attorney or a reference librarian.

If you have a document/citation as the starting point for your research:

- READ the document.
- Highlight cited resources within the document that are relevant to the issue which you have been asked to research.
  - Read these resources.
- If you have an annotated document, such as an annotated statute or regulation, read the annotations and pull out relevant materials & citations.
- Shepardize/KeyCite the document – all primary sources have citing references; some secondary sources do as well.
Other Tips:

- Law firms and other legal offices often have their own work product banks, so you can see previous examples of forms, briefs, etc., produced by the organizations own attorneys.
- If you’re faced with a topic about which you know nothing, start by looking at research guides rather than jumping straight into a paid database such as WestlawNext or Lexis Advance.
  - The LIC has several research guides, at [http://guides.law.ufl.edu/](http://guides.law.ufl.edu/)
  - Google the broad topic plus “research guide.”
    - E.g. administrative law research guide
    - Look for research guides from respected law schools in your results.
- Ask questions, clarify information, and double check your facts.
- Be familiar with the court system and legislative process for your jurisdiction.
- Keep track of your research, either through folders on Westlaw and Lexis, or a research log. Don’t incur the costs of re-researching something.

Common pitfalls:

- Using only keyword searching.
  - Make use of finding aids, such as tables of contents, headnotes, and indexes.
- Consulting too few/inadequate secondary sources.
- Going outside of your organization’s database plan – stop when you see the warning about charges and ask.
- Forgetting to plan your research.
- Forgetting to track your research.
- Not asking for help when you need it.
- Citing to Wikipedia or a random webpage.
- Forgetting about all the resources you have available to you:
  - Lexis/West/Bloomberg research attorneys.
  - Law librarians, both at your organization and here at UF Law.
  - Your supervising attorney/other attorneys in the organization.
    - It is better to ask questions than waste time researching and answering the wrong thing.
    - Your organization’s form/sample bank.
- Relying on information that you Googled without verifying its source and accuracy.
RESEARCH CHECKLIST

Use the Five Steps of Legal Research

- What legal questions are you researching? What information do you need to answer the question(s)?
- Follow the Five Step Research Process -- remember it is a cyclical, repetitive process, not a linear process
- Research plan
  - Question presented/issue
  - Parties
  - Area of Law
  - Jurisdiction
  - Search terms & search strings
  - Key facts
- Find Secondary Sources
  - Use different secondary sources: legal encyclopedias, ALRs, treatises, practice guides
  - When you find a relevant section, look at the table of contents around that section to see if there are any other relevant sections
  - Use different finding methods in the same sources:
    - Tables of Contents,
    - indexes,
    - keyword searches & natural language searches,
    - Boolean (terms & connectors) searches
- Find, Update, and Expand Primary Sources
  - Look for statutes first
  - When you find a relevant statute:
    - use the annotations from statutes to navigate to other primary sources
      - use the notes of decisions to find cases that analyze the statute in depth
      - use the citing references to find all of the cases that cite to the statute
    - when you find a relevant section, look at the table of contents around that section to see if there are any other relevant sections
  - Find cases
    - Use headnotes and the KeyCite/Shepard’s systems to expand your cases
      - Click on the headnote to get cases that cite to that case for the proposition of law in that headnote
      - Click on the KeyNumber/Topic to get all of the cases that have been indexed under that topic
      - Triple check the jurisdiction
      - Use the citing references/citing decisions to find other cases
    - Update any primary source using KeyCite/Shepard’s to make sure that your case, statute, regulation, is still good law
- Organize and Analyze
  - Can you correctly and thoroughly answer the questions asked?
  - Do you cite to a primary source for every assertion that you make in your answers?
Circle back to what you were asked – are you answering only what the question asked and have not veered onto any tangents?

Know when to stop:

- **Note:** When you begin writing, you may find that you need to do additional research. This is normal.
- When you have:
  - Found at LEAST ONE secondary source and primary sources for each legal question to be answered
  - Searched in the statutes using an index and/or table of contents as well as keyword searching
  - Searched for cases using keyword searching, headnotes, citator
  - Found a complete answer to your legal question(s)
- When you start to see the same materials cited repeatedly (cases, statutes, and secondary sources)
- When you have run out of time—“you’re done when it’s due”
- When you have run out of resources
  - You’ve looked in all the materials you have access to, or that the client will pay for
- When everything is updated and current
  - You’ve checked citators, currency notes, pocket parts
- For a video explanation, see http://youtu.be/elavylhLqTgk.

Final Check

- All questions are answered? Is it clear which question you are answering?
- Run a grammar/spelling check in Word.
- Give the document a name that clearly conveys its contents.
- Have you provided clear and concise explanations and answers?
- Review for egregious mistakes and overall completeness
  - Bluebook
  - No abbreviations (unless it’s a common abbreviation and you spell it out the first time you use it, then provide the abbreviation)